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Welcome

Welcome to C-BrEase 

C-BrEase is a software application written by H2Flo Consulting for the purpose of making
the plotting and analysis of channel cross-sections simple and informative for engineers. 

https://www.helpndoc.com
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First created in 1997, the original program was known as BrEase and operated as an
application of Microsoft Excel.  Newly rewritten in 2017 using the programing language C#
as a stand-alone program, C-BrEase now has greater flexibility, improved stability and
more capabilities than ever before.

For more information about C-BrEase or the services of H2Flo Consulting, please visit the
website.

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

Why C-BrEase?

Why C-BrEase? 

C-BrEase  provides a streamlined approach to plotting channel cross-sections.

Past studies of bridge failures have demonstrated the essential value of maintaining
accurate, graphical records of channel cross-sections at bridge openings to assess
channel instability and to identify potential vulnerabilities with the bridge foundation.

C-BrEase has been specifically designed to make the calculation of channel cross-
sections efficient for the engineer in order to highlight important changes in the channel
which might indicate channel stability concerns.

To do this, the program was designed to accurately calculate the channel cross-section
data and create plots that relates the historic channel cross-sections with the bridge
foundation.

Accurate Cross-Section Calculations

To calculate the correct elevation of each cross-section data point, C-BrEase accounts for 

o Variations in the Bridge Geometrics
§ cross-slope
§ superstructure depths
§ bridge vertical alignment
§ bridge skew

o Adjusts for Measurement Offsets
§ Rail height
§ Tape leader

o Allows for Flexible Data collection methods
§ Laser readings
§ Weighted tape
§ Stationing based on face of substructure item

Visually Compelling Plots

To generate meaningful plots of the bridge and channel cross-sections, C-BrEase offers 

http://www.h2floconsulting.com
https://www.helpndoc.com


C-BrEase

6 / 66

o Flexible Displays
§ Turn on and off different cross-sections
§ Annotate the chart to show key points of interest
§ Quickly adjust the line style, thickness and color of each cross-section

o Interactive Charts
§ Easily zoom into important locations
§ Quickly compare elevation data from various years

Created with the Standard Edition of HelpNDoc: Free EPub producer

What's New?

What's New?

C-BrEase will be  comprised of 3 modules: 
1. Historic Channel Cross-Section Monitoring
2. Field Data Collection on Mobile Devices
3. Hydraulic Calculations and Scour Computations

The initial release of C-BrEase will only include the cross-section monitoring module. 

Compared to earlier versions of BrEase, many new features have been added to make C-
BrEase more useful like 

o Greater flexibility to add unique superstructure details and vertical alignments
o Graphical view of individual bridge items during input
o Texture fill for Bridge elements for more realistic looking structure
o Quick means to change plot elements such as line thickness, opacity of

substructure, etc.
o Solid earth representation of channel
o Rapid zooming and panning of bridge plots
o Enhanced annotation system
o Integrated Help System 

However, compared to the prior versions of BrEase, the C-BrEase no longer supports the
following features:

o Nonbridge Option for cross-sections not located at bridge site
o Clearance Diagram

Created with the Standard Edition of HelpNDoc: Easily create CHM Help documents

Release History

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/feature-tour
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C-BrEase Release History

Version 1.0 - Released July 6, 2017

Version 1.1.0 - Released September 19, 2017
o Added Option to Name Report Files
o Printing

§ Cleaned up missing legend on charts
§ Removed Status Strip from print
§ Added Paper Size Options
§ Removed bug when printing charts without report

o Editing Annotations on Charts
§ Enabled moving of Bridge Labels
§ Enabled moving of annotations with mouse
§ Enabled changing font size, line size and rock size with mouse

o Fixed Licensing bug which locked out user if wrong password used

Version 1.1.1 - Released November 27, 2017
o Added Trace Values of Deck and Soffit on Chart
o Fixed Bug in X-Section Input to prevent hiding of Point Entries upon selecting

From Item

Version 1.1.2 - February 8, 2018
o Corrected Bug which ignored Vertical Adjustments to X-Sections points on

Read-in of *.cbz file.  
Subsequently, when the file was saved, all Vertical Adjustment Values were
being set to False.

Version 1.2.0 - July 7, 2018
o Corrected Bug which ignored referencing face of substructure item for station in

cross-section calculations
o Added Status Strip help for all fields in form
o Added Hydraulic Module with Rating Curve and Risk Analysis

Version 1.2.1 - October 5, 2018
o Added Pier Scour Module based on CSU Pier Scour Equation
o Added Risk Analysis for Pier Scour

Version 1.2.2 - February 24, 2019
o Improved validation on Hydraulics module
o Fixed Issue causing the PDF Report to crash
o Fixed Bug with Bridge Labels on Charts
o Reorganized image  files in Program directory

Version 1.2.3 - March 3, 2019
o Improved Zooming on Charts
o Fixed Bug in Annotations on Charts
o Fixed Bug for Superstructure Length

Version 1.2.4 - September 2020
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o Improved Chart Labels
o Addtion of Markers for Plots
o Rotation of Annotations on Charts
o Bugs fixed for modifying Annotation Table Entries
o Bugs fixed for Saving Chart Images and Printing Charts
o Export for Cross-Sections Added for both Survey Data and General Cross-

Sections
o Bug fixes on X-Section Entries
o Bugs fixes for Font Size on Chart Title and Axis Labels

Version 1.2.5 - June 2021
o Improved Chart Labels by allowing rotation of text
o Allow for renumbering/renaming of Substructure Item Numbers/Names
o Addition of Import of Cross-Sections from Text File
o Fixed bug in labels using Metric Units

Created with the Standard Edition of HelpNDoc: Full-featured Documentation generator

Getting Started

Let's Get Started

C-BrEase is designed to be an intuitive program which provides the user with a clear and
consistent approach to plotting channel cross-sections at bridge openings. 

Using As-Built Bridge Plans and field measurements of channel cross-sections, one can
develop accurate and professional plots that illuminate channel changes and potential
problems at bridge site.

To navigate in C-BrEase, one uses  User Forms to  input data and for commands for
generating and modifying plots.

Created with the Standard Edition of HelpNDoc: Easily create EBooks

System requirements

System Requirements 

Hardware and Software Requirements

The computational and graphical demands for C-BrEase are fairly low making the
program usable on most PCs and Laptop computers running Microsoft Windows 7 or later.

C-BrEase is built on the Microsoft .Net Framework and requires Version 4.5 or later.

https://www.helpndoc.com
https://www.helpndoc.com/feature-tour
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Created with the Standard Edition of HelpNDoc: Free help authoring tool

Evaluating C-BrEase

Evaluating C-BrEase

Upon starting C-BrEase for the first time, a 30-day license will be automatically generated.
 The evaluation license is fully functional, but will place a "Demo Document" watermark on
the PDF Report Documents.

After the evaluation period, you will no longer be able to open, modify, save C-BrEase files
or in any other way use the C-BrEase program.

To upgrade to a Paid Version of C-BrEase, see the help section on License Registration.

For more information on acquiring a Paid Version of C-BrEase, visit the following web
page or contact sales@h2floconsulting.com or 916-832-5327.

Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

Getting help

HELP

Help Button

On each user form, a Help Button, , is located at the upper right corner of the form to
provide specific guidance for that section of the user form.

After clicking the  button, you can select various items on the form to open the Help
file document to the topic which is relevant to the selection.

Status Strip

In the lower left corner of the form, instructions are given in the Status Strip for what
information or action is required for each  field or tool on the form.  
To access this information, hover the mouse over the textbox, dropdown box or combo box
to see the display in the Status Strip as as highlighted in the image below.

https://www.helpndoc.com/help-authoring-tool
https://www.h2floconsulting.com/c-brease-software/
https://www.h2floconsulting.com/c-brease-software/
mailto:sales@h2floconsulting.com?subject=C-BrEase Sales Info
https://www.helpndoc.com
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To report bugs or if you need additional assistance, please email
support@h2floconsulting.com

Created with the Standard Edition of HelpNDoc: Free EPub producer

Program Organization

Program Organization

C-BrEase uses User Forms to record and display bridge and cross-section data.  

The Project Information, Bridge Data and Cross-Section Data is entered and modified
through the General Form.  

In addition, the General Form is used to Create Charts, Open and Save Files and Print
Reports.
 

Created with the Standard Edition of HelpNDoc: Free EBook and documentation generator

General Form

GENERAL FORM

The General User Form will automatically be displayed when 
C-BrEase is opened.

mailto:support@h2floconsulting.com
https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com


C-BrEase

11 / 66

Organization of the General User Form

The General Form in C-BrEase consists of 6 Tabs (Pages) which show across the
User Form as show below.

1. Project Info - for entering project related information

2. Vertical Alignment - for specifying the type vertical alignment of the bridge

3. Cross Slope - for defining the  cross-slope and distance to the edge of deck

4. Superstructure - for defining the structural depth of the bridge

5. Substructure - for defining the dimensions and elevations of the substructure
elements

6. Cross-Sections - for entering the data about the cross-sections

7. Hydraulics - for entering hydraulic parameters and executing hydraulic analysis.
Note: The Tab is only available as an Add-On Extension of C-BrEase and will
not be visible under the Licensing
for the basic program.  See www.h2floconsulting.com for more information about
purchasing the Hydraulic Add-On.

One moves between the tabs by clicking on the Tab you want to access.

Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Chart Form

CHART FORM

The Chart  Form provides  a set of tools and commands by which user can easily modify
and adjust the Chart generated by C-BrEase.

Below are the menu options to control the appearance of the Chart.

1. File -  for managing the project including printing and saving charts

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
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2. Toggle Cross-Sections - for turning on and off X-sections and modifying the
presentation of the x-section 

3. Layers - for changing the visibility and color of components of the chart

4. Add - for adding annotation to the chart

5. Zoom - for focusing on specific parts of the bridge/cross-section

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

File Organization

File Organization

There are 4 types of files generated by  C-BrEase:

1. Project Files for C-BrEase are ascii (text) files and may be stored to any
location on your hard drive or other storage medium and will have the file
extension "cbz" (i.e., sample.cbz).  Information in these files can be viewed using
any text editor such as Notepad, Wordpad or Microsoft Word.

2. Image files of the Charts can be saved individually as "jpg" files. 

3. Report files documenting the bridge and cross-section inputs are recorded as
PDF files.

4. Hydraulic Risk assessment ascii  files used for future scour analysis and
recorded as "risk_estimate.cbz"

Created with the Standard Edition of HelpNDoc: Qt Help documentation made easy

General Form

The General User Form is comprised of the following 6 Required Tabs and 2 Optional
Tabs.
The first 6 Tabs are for the development of the bridge and cross-section plots.
The last 2 Tabs are for the optional license purchase for analyzing hydraulic and scour
calculations

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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In principle, it is best to start with the Project Info Tab, then proceed to completing each
subsequent tab moving to the right. 

If critical information is missing, you will be alerted by a flashing red dot  when trying to
move on prematurely as shown below.

Created with the Standard Edition of HelpNDoc: Produce Kindle eBooks easily

Menu Items

General Form Menu System

The Menu system for the General Form consists of the following 3 Items

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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The Sub Menu Items for the File Menu Item are as follows:

Clicking the AutoSave Menu Item will toggle the program to Save the *.cbz file every 1 minute.

The Write Report Option will provide the user with a summary PDF report of the data entered for the project,
bridge geometry and cross-sections.

The Registration Menu Option provides options to 

o View the current registration information, 

o Register the program o 

o Deactivate a License on one computer to move it to another computer

The Sub Menu Items for the Chart Menu Item are as follows:

To Plot a Chart of the Data, choose the View Chart Item.

To view a previously saved chart, select the chart of interest (e.g., Chart 1 or Chart 2 in the example above)

The Sub Menu Items for the Window Menu Item are shown as below to either Minimize or Maximize the
General Form on the Monitor.
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Created with the Standard Edition of HelpNDoc: Free EPub producer

License Registration

License Registration

To Register C-BrEase, select the Register Program Option and form showing the
Product ID will appear.  Copy the Product ID to the clipboard and mail to
sales@h2floconsulting.com.  Upon receipt of the Product ID and payment for a license, a
Registration Code will be emailed back to you which you can enter in the same form as
shown below.

After clicking the Validate Button, you should see a message confirming the validation.  To
complete the registration, close C-BrEase and restart.

https://www.helpndoc.com/create-epub-ebooks
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Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

License Deactivation

License Deactivation

If your license is limited to a specific machine and you want to move the C-BrEase license
to another computer, the active license must be deactivated by selecting the menu option
below and following the instructions provided on the user form.

Once deactivated, a new license can be acquired from support@h2floconsulting.com
following the directions for License Registration.

Created with the Standard Edition of HelpNDoc: Full-featured multi-format Help generator

https://www.helpndoc.com/feature-tour/iphone-website-generation
mailto:support@h2floconsulting.com?subject=License Deactivation
https://www.helpndoc.com/help-authoring-tool
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Project Information

Project Information

Basic identifying information regarding the project is found on this tab.

Specifically, the bridge number or ID, the bridge name and bridge location are recorded on this tab.

In addition, one must select which side of the bridge (upstream or downstream) that will be used for the
cross-section location.  

The bridge number/ID and side of bridge are used to automatically define the file name for the project (e.g.,
Bridge 99-0011 with cross-sections on the the upstream side will be named "99-0011 Upstream.cbz").

Note: If cross-sections will be recorded on both sides of the bridge, then 2 separate C-BrEase files will be
required.  Typically, the only difference between the upstream and downstream bridge data is the direction of
the bridge skew and cross-slope information.

The Unit System (English or Metric) is selected on this tab.

Optionally, the Original User and Current User names can optionally be entered on this page.

Created with the Standard Edition of HelpNDoc: Produce electronic books easily

https://www.helpndoc.com/create-epub-ebooks
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Vertical Alignment

Vertical Alignment

Three options are provided to define the vertical alignment of the bridge.

Use this option for flat bridge decks

Use this option of decks that follow a constant slope

Use this option if the highway and bridge are on one or 
more vertical curves.

Created with the Standard Edition of HelpNDoc: Produce online help for Qt applications

Level Grade

Level Grade

Use this option for flat bridge decks.

All that needs to be entered is the elevation of the layout line for the bridge.

Created with the Standard Edition of HelpNDoc: Benefits of a Help Authoring Tool

Constant Grade

Constant Grade

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpauthoringsoftware.com
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Use this option for bridge decks that follow a constant slope along the full length of the bridge.

To define a constant grade, any point (e.g., beginning of bridge) with a known station, elevation and grade
can be used.

NOTES
1. The Station information can be entered as a standard number ("110.50" or with the station delineation as

"1+10.50"), but will be displayed with the "+" stationing as shown in the diagram below.

2. The slope should be entered as a percentage rather than in decimal form (for a -2.1% slope enter -2.1,
NOT -0.021) as shown above.

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Vertical Curves

1 or More Vertical Curves

Use this option for bridge decks that are on an alignment defined by 1 or more vertical curves.

There is no limit to how many vertical curves can be used with C-BrEase.
To define a vertical curve, one must enter the Station, Elevation and Percent Grade at the beginning and end
of each vertical curve.  

https://www.helpndoc.com/help-authoring-tool
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Like the data for the Constant Grade, the Station data may be entered in either decimal form (123.45) or
station notation (1+23.45), but will be displayed in typical station format.   The Grade information is entered
as a percent (e.g, enter 1.25 for 1.25%).

After entering the BVC and EVC data, click the  button which will store the data and list it

in the drop down box for later viewing or modification.

To create an additional vertical curve, click the  button.

All of the vertical curve data is displayed in the summary table at the bottom of the form.

Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

Cross Slope

Cross Slope

To adjust the profile grade elevation along the layout line to the elevation at point of the
cross-section measurement along the edge of the deck, the cross slope of the bridge deck
must be taken into account.

To do this, first enter the

Next, two options are provided to define the cross slope of the bridge deck depending on
whether the bridge is located in a super-elevation transition or not.

https://www.helpndoc.com
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Created with the Standard Edition of HelpNDoc: Easy EPub and documentation editor

Constant Cross Slope

Constant Cross Slope - enter a single value for the cross slope using a negative
value when the edge of deck is below the layout line and a positive value if the
edge of deck is above the layout line.  The value of the cross slope should be
entered as a percent (e.g., enter -0.012 if the slope is -1.2%)

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

https://www.helpndoc.com
https://www.helpndoc.com/help-authoring-tool
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Varying Cross Slope

Varying Cross Slope - Data for for a varying cross slope is input as key points
according to the station and cross slope.  Values for the cross slope at a particular
location will be interpolated linearly according to figure below and displayed in the
summary table on the right after clicking the button to Save the Cross Slope.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Superstructure

Superstructure

The Superstructure is defined by the structural depth which can be a constant value or a
varying template.

https://www.helpndoc.com/help-authoring-tool
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However, if a bridge has multiple constant structural depths, it is possible to represent this
in C-BrEase by creating 2 Varying Structural Depth Templates - each with a constant
structural depth for each as shown below.

Created with the Standard Edition of HelpNDoc: Qt Help documentation made easy

Constant Structural Depth

Constant Structural Depth

For bridge with a constant depth such as are defined by slabs, box girders and most
girders, use the constant structural depth option to define the depth.

Created with the Standard Edition of HelpNDoc: Full-featured Documentation generator

Varying Structrual Depth

Varying Structural Depth

For bridge with a variable structural depth such as arch type bridges, select the check box
as below

After checking the box, new input fields will appear for you to define a template for the
variable depth.  Templates can be defined for either the left or right side of the bridge item,
so you will then need to select which side of the substructure item you are creating a
template.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com
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After choosing the side of the template, enter points to define the depth of the
superstructure as referenced from the centerline of the bridge item.

  

After entering the data and clicking the  button, the data will be
recorded the template and displayed in the table the right side of the form and displayed in
the preview chart.
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You can choose the modify or delete  individual data points by right clicking on the value in
the table and switch between existing templates by choosing a different template in the
drop down box at the top.

Modifying and Deleting Key Points

To Modify or Delete a Point after it was saved, Right Click on the point your wish to change
and select either Edit or Delete from the Context Menu.

If you choose Edit, then the existing value you selected with be written into the Distance and
Depth Boxes where you can change them and resave them by clicking the Modify Variable
Depth Button below the values.

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Substructure

https://www.helpndoc.com/feature-tour
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Substructure

To Add a New Bridge Item, 

Click the  button.

For each bridge item, basic information needs to be entered to describe the type of
element, its stationing, the bridge skew of the item and whether a variable superstructure is
applied to either side of the bridge item as show below.

The Name / No. Field is automatically assigned to match the value in the "Select Field"
drop down item which would typlically be appropriate;  however, you may change this value
to whatever value or name you wish.

For bridge skew, enter a positive skew value in degrees if the projected station from the
bridge item at edge of deck is farther ahead on station or a negative skew value if it is
behind on station as shown below.

Next,  the type of substructure of substructure for each bridge item needs to be selected.  In
C-BrEase, there are possible types of substructures available as show below.
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Depending on the type of substructure selected, various input textboxes will become visible
for you to supply the appropriate geometric information.   In all cases the column
information is required; however, information regarding piles and tremie seals may or may
not be needed depending on the type of foundation.

For the case of pile cap with a tremie seal, all the data fields are required as shown below.

For cases of "Unknown Foundations", only the column information is required.  For this
case the column will terminate at the ground line in the Chart.

By clicking the    button, one can preview the individual bridge item.

After entering all of the required information for a particular bridge item, click the

 button to record the data and display it on the table at the bottom of
the form.
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Note: if a substructure item is inserted with a station between two other substructure
stations, the data will be automatically reordered.

To Modify an Item Numbers Automatically

The Name / No. Field is automatically assigned to match the value in the "Select Field"
drop down item when the Substructure item is created.  

In some rare cases; however, you may want change this value to a different name or
number.  For instance, if the naming convention is opposite of the stationing then you may
wish to reverse the numbering.  To reverse the numbering for all items automatically,
change the first item number to the last value and you will be asked if  you would like C-
Brease to reverse all the values.

For instance, if a bridge has 5 substructure items that you would like to reverse the
numbering, then change Item 1 to 5 and agree to have the program change all of the
values.

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Cross-Sections

Cross-Sections

Cross-Section Data consists of the date, measurement offsets, vertical and horizontal
measurements and point values and descriptions.

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Date

Cross-Section Date

After clicking the  button, one adds the cross section date by using the
calendar.

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/feature-tour/iphone-website-generation
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Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Type of Cross-Sections

Type of Cross-Section Data

Three types of data can be used for C-BrEase Cross-Sections:

1.  Channel X-Sections - used for cross-sections taken using traditional bridge inspection
methods such as a weighted tape or laser.

2.  Engineering Plans or Surveys - used when you are entering a horizonatal distance and
elevation values obtained from traditional survey methods or sonar surveys or from plans
such as Foundation Plans and create a list of horizontal distances and elevations.

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Support Data

Support Data

In the remaining part of the left box, 

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/feature-tour
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· Comments can be added such as might relate to the nature, quality or reference of the
measurements.  

· The name of the inspector can be documented in the "Collected By" field.

· The vertical distance from where the measurement is taken and the edge of the deck
can be entered

· A vertical offset such as for a tape leader or rod height can be applied to the collected
data

· A checkbox can be selected if the horizontal measurements are referenced to the
column face of an element rather than its centerline station.

· If a constant vertical alignment other than the bridge deck is referenced for a cross-
section, such as could occur if one were taking depth readings from a boat where the
water surface elevation was known, check the box next to "Use Constant Elevation for
Vertical Reference", then supply a constant reference elevation for the cross-section
points.

Created with the Standard Edition of HelpNDoc: Write eBooks for the Kindle

Recording Data Points

Cross-Section Data Points

The actual cross-section points are input in the box at the top.

· The point number is automatically generated.

· The "From Item" reflects the bridge item for which the horizontal measurement is based.  While
commonly this is Item 1 for all points if say all the horizontal readings were taken from the beginning of
the bridge, it is possible to reference different items such as when using a laser from below the bridge.

· The Horizontal Distance for the point is commonly positive when all points are taken from a single
reference bridge item, but can be entered as negative when the reference item is ahead on station from
the measurement point.

· The Vertical Distance as measured.

· The Add Vertical Adjustment adds the vertical offset to the vertical measurement.

· Select from the drop down list or enter your own description of the point as desired.

 Click the   button to add additional points.  This will also record the cross section point and write it
onto the summary table as shown below.

Note:  To modify or delete any particular point, right click on the point of interest and select your
desired action.

If a substructure item is inserted with a station between two other substructure stations, the data will
be automatically reordered.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Entering Data for Engineering Survey Data or Engineering Plans, the input values will be slightly different.

For Survey data, one enters only the Station and Elevation Value.

For Engineering Plans, one enters the Horizontal Distance and Elevation Value.

Created with the Standard Edition of HelpNDoc: Full-featured Help generator

Exporting Cross-Sections

Exporting Cross-Sections

Cross-Sections can be exported to a CSV (comma-delimited) format by clicking the Export XS button at
the bottom of the tab.

https://www.helpndoc.com/feature-tour
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Clicking the Export XS button will open a new User Form 

On this form, you see two export formats:

1. Bridge X-Section Format
This selection will export each point in the cross-section with horizontal and vertical values.
The user can modify the output if desired in 3 ways:

i) Use "Horizontal Distance from Beginning of Bridge" to mimick having all horizontal values
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starting at the beginning of the bridge.
ii) Use "Vertical Distance from Bridge Deck" to reference all the vertical measurements to

the top of deck at the edge of the bridge.
ii) Use "Metric" to have both the horizontal and vertical values converted to metric units

2. Survey Coordinate Format
This selction is intended to be used if you would like to use the cross-section data in a a program

requiring Survey Coordinates such as the Surface-Water Modeling System (SMS) by Aquaveo TM

Selecting this option will show additional inputs a to enter the starting Easting, and Northing values
for the cross-section which is not found in C-BrEase nbut will need to be found using another means
such as a GPS measurement.

In addition, you will need to enter a bearing line in degrees for the direction of the cross-section
using East as 0 degrees and CCW as the direction of the angle.

Clicking the "Export" Button will provide you with an opportunity to name the file and provide a path.  By
default, the file is named with "BridgeNumber_xs_mmddyyyy.csv and will be stored in the same directory as
the cbz file.
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Importing Cross-Sections

Importing Cross-Sections

Cross-Sections can be imported as text files.  This feature was originally  intended to be used with the SMS
software from Aquaveo when observation lines are drawn along the bathymetry and points are extracted;
however, this feature may be useful anytime data exists in a text or spreadsheet file as long as it is saved in
the proper file structure and format. 

The required format for import is:  "Dummy' , "Dummy" , Horz. Distance , Elevation
where "Dummy' can be any string or left blank as 

To use this feature, 

1. Click the Create New button under the Cross-Sections Tab and enter the date of the cross-section.
A new button will appear at the bottom of the form labeled Import XS.

https://www.helpndoc.com
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2. Click the Import XS Button a nd a new user form will appear.
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3. On the user form, you need to

  (1) Browse to the file you want to import and select Open

  (2) Enter the type of delimeter used iin the import file (comma by default)

  (3) Use the dropdown list to selct which  station at the bridge corresponding to where the
imported cross-section is referenced.

 (4) Enter the horizontal distance from the reference station to the first point of the imported
cross-section.

Note:  if the first point corresponds to the bridge item station referenced  in (3) above, enter
0.

The cross-section should poputate the appropriate fields in the form and let you know the number of
points that were imported.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Hydraulics

Hydraulics 

If the Hydraulics and Scour Licensing has been acquired, then two additional Tabs will appear at the Right to
access these modules:

The Hydraulics Tab provides 3 tools for the engineer to estimate hydraulic conditions for Cross-Sections in

C-BrEase as described below.  For more information on how to use these tools, click on the
corresponding Hyperlinks.

https://www.helpndoc.com/help-authoring-tool
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1. Solving with the Basic Normal Depth Hydraulic Calculator.

This tool will estimate either 

o the water surface elevation for a known discharge or 

o the discharge for a given water surface elevation
      

      The tool is graphical in design and can calculate flows with multiple mannings values, overbanks and for
known amounts of backwater.

2. Rating Curve

A Rating Curve can be easily generated for a set of hydraulic parameters providing the flow rate for the
range of possible flow levels in the channel

3. Risk Analysis

To help Hydraulic Engineers better understand the possible range of flow conditions and to help define
and quantify the uncertainty with Hydraulic parameters, the Risk Estimation Tool provides a power
means of running Monte Carlo Simulations for the flow based on the level of uncertainty of the data.
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Normal Depth Calculator

Normal Depth Calculator

The Hydraulic Calculator  is estimates the flow according to a single cross-section via Mannings Equation.  

https://www.helpndoc.com/help-authoring-tool
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Inherent in the Mannings Equation is the assumption that flow is "Uniform" or "Normal" meaning that there is
no acceleration of the flow.  In this condition, the flow upstram and downstream of the cross-sctioon should
be identical in depth and velocity.  Strictly speaking, for this to be true, there can be no change in

· channel geometry, 

· alignment (i.e, no bends), 

· roughness, or

·  slope.  

Other than in laboratory flumes or man-made canals, this will not occur in nature. However, as a rough
assumption, Mannings Equation can provide a good estimate of the flow conditions when the above
conditions are not severely violated.

The Hydraulic Tab consists of 3 Main Parts shown below:

1. Hydraulic Parameter Input
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Below are descriptions of the various fields and selection options for the Hydraulic analysis

1.

Case represents the current
simulation parameters.  You can
create new simulations by choosing
"Create New" from the dropdown list.

XS allows you to select from any
previously saved Channel Cross-
Sections to use in the Hydraulic
Calculation

Solve allows you to choose either to
solve for Water Surface Elevation
from a known Flow Rate or to
calculate the Flow Rate from a known
water surface elevation.

WSEL is the user provided Water
Surface Elevation used for calculating
the Flow Rate or the Calculated
Water Surface Elevation when solving
for WSEL

Mannings Value Options:
 You can choose to use a single
Manning value for the entire Cross-
Section by entering the value in the
textbox below 
or choose to use Multiple Mannings
Values clicking the radio button then
clicking the button below 

and graphically drawing on the Chart
the location and values of multiple
Mannings Values where the values
are shown on the chart and colored
by n-values (See chart below)

Slope is for entering the channel
slope.  Use decimal values (e.g., 0.01
for a 1% slope)

Overbanks allows you to choose
to have a Left and/or Right Overbank
defined for the calculations which is
essential for obtaining a correct value
when floodplains exist.
You can add the overbank locations
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graphically by clicking the appropriate
"Add Left Overbank" or "Add Right
Overbank" button and graphically
selecting the station on the chart

Normalizing Angle is used to
correct for Cross-Sections which do
not cross perpendicular to the
channel.  Enter the angle to normalize
the flow area.

XS Slices can be used to
dynamically divide the channel into
slices (a.k.a., stream tubes) to
display graphically on the chart values
of velocity, unit flow rate and/or shear
stress

2. Graphical Display

Below is an example of an chart of a hydraulic calculation.  
Note that the Overbanks are defined, multiple Mannings values are provided and slice information is given.

3. Output Table

The results from the Hydraulic Calculation are shown in the Output Table.  The values on theLeft side
represent Channel average values.
On the Righthalf of the Table the values are separately calculated for each Overbank and the Main Channel.
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Rating Curve

Rating Curve

The Rating Curve shows how the Discharge varies with Depth/Water Surface Elevation.
After the Hydraulic Parameters have been entered, then a Rating Curve can be generated by clicking the

button which located to the bottom right of the Chart.
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Risk Estimate

Risk Analysis

For each Hydraulic parameter in the Normal Depth Calculation, uncertain may exist regarding the accuracy
of the parameter.  For instance, through a Hydrologic analysis of a Stream Gage, the a 100-Year Flow Rate

https://www.helpndoc.com
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(Q100) may be determined; however, there is always a Standard Deviation associated with the value which
reflects the level of confidence or uncertainty for the value.  The Risk Analysis allows the User to see how
the Uncertainty for Various Parameters may combine to generate a Range of Water Surface Elevations and
Velocities by running numerous Monte Carlo simulations.

Input 

To run the analysis for a desired Confidence Value, enter the degree of confidence (1 - 99.9%) in the
fielld as shown below:

After starting the Risk Analysis, the field for the various parameters will be automatically assigned a
Constant Distribution value and filled with the values used in the Basic Normal Depth Calculator.
However, the Risk Analysis requires that a least one of the parameters be defined with a "Non-Constant"
Probability Distribution Function (PDF) in order to randomly generate different results.

To define the Uncertainty for the various Hydraulic Parameters, you can select a PDF type  from the
drop down list for each item.  The options for PDF's are 

 

o A Constant Value assumes no uncertainty and the single value shown in the adjacent Text
Box will be used for all simulations.

o A Uniform Distribution assumes that all values between the minimum and maximum range
are equally possible.

o A Triangular Distribution assumes that all values will be between the minimum and maximum
values, but will be proportionally more likely be randomly selected near the value in the middle
Text Box
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o A Normal Distribution (a.k.a., a Gaussian Distribution) follows a typical Bell shaped curve 

By defining the median and standard deviation, the probability of randomly choosing values within 

§ 1 standard deviation is  68.27%, 

§ 2 standard deviations is 95.45%

§ 3 standard deviations is  99.73%

o A Log-normal Distribution is a continuous probability distribution of a random variable whose
logarithm is normally distributed and will only have positive real values.

Running a Simulation

After defining the various PDFs for your Hydraulic Inputs, you then choose the level of effort (number
of simulations) for the Monte Carlo Simulations

with Low Effort simulating 5000 cases, Medium Effort  simulating 25,000 cases and High Effort
Simulating 100,000 cases.

Typically, Low Effort will provide a reasonable estimate for the results.

Click the Analyze Button to start the Simulations
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Output

While the simulation is running, you can see a Histogram for  Water Surface Elevation  and Main
Channel Velocities develop and the corresponding statistical values for each displayed.

At the bottom of the Output, the Confidence Level (default 95%) set in the Input Section will show
the value for the Water Surface Elevation and Main Channel Velocity corresponding to the
percentage of simulations with values below the required Confidence Level.
In the case below, it was determined that 95% of the simulations had a Water Surface Elevation
below 243.13 ft and a Velocity less than 2.46 ft/s.

To Save the Risk Analysis for future use such as for Scour Risk Analysis, Click the

button and the randomly generated parameters and results will be
saved in a ascii file called "risk_estimate.cbz".
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Scour

Scour 

Selecting the  Scour Tab provides access to 4 types of scour analysis as described below; however, in
Version 1.2.1 only the Local Pier Scour is currently available.  
To use the Scour module, you create a Scour Case which comprises the Hydraulic Case, X-Section and

https://www.helpndoc.com/feature-tour
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Scour values.  Mulitiple cases can be saved with variations in any of these parameters.

Local Pier Scour 

Created with the Standard Edition of HelpNDoc: Free EBook and documentation generator

Pier Scour

Local Pier Scour

The local pier scour computation uses the CSU Pier Scour Equations found in the FHWA HEC-18 Manual,
Evaluating Scour at Bridges, 5th Edition 
as shown below in Equation 7.3 of the manual:

Scour calculations are made 1 pier at a time as selected in the dropdown box.
As Input Parameters are entered, intermediate calculations are immediately displayed.  
After all parameters are entered, the scour elevation is shown at the bottom and displayed graphically.
Results can be saved for display on the overall bridge plot shown on the Scour Tab.

Alternatively, input parameters can be estimated using probabilities and the scour determined by Risk
Estimate.

https://www.helpndoc.com
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Risk Analysis for Scour

Pier Scour Risk Estimate

https://www.helpndoc.com/feature-tour/iphone-website-generation
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Chart Form

CHART FORM

The Chart  Form provides a visual representation of the bridge and cross-section data. 
The chart can be modified, saved for future reference and printed for documentation.

https://www.helpndoc.com/create-epub-ebooks


C-BrEase

47 / 66

Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Creating, Saving and Printing

CHART FORM - Creating, Saving and Printing

Creating a Chart
The Chart  Form is created from the General Form using the Chart => View Chart
Command from the Menu

Saving a Chart as a Image
To Save the Chart as a JPG image for future use, execute the File => Save Image
Command from the Menu

https://www.helpndoc.com/help-authoring-tool
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JPG Images can be imported into documents or further modified using a program like
Microsoft Paint.

Saving a Chart for Later Recall
To Save the Chart with User Settings as part of the project file (*.cbz), execute the File =>
Save Chart Command from the Menu and provide a Name in the textbox adjacent to the
Save Chart Command.  

Saving a Chart for Later Recall
To Save the Chart with User Settings as part of the project file (*.cbz), execute the File =>
Save Chart As Command from the Menu and provide a Name in the textbox adjacent to
the Save Chart As Command.  

The user's Annotations and Zoom Level will be stored for all Saved Charts and the charts
will be recreated when the *.cbz file is reopened by the User.

After saving the project file, you will be able to reopen the Chart with the Name you
identified in the General Form Menu under Chart as
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The Chart can be further annotated or modified and resaved using the Save Chart
command.

Printing a Chart
To Print a Chart, select the Print Chart Menu Item under File in the Chart Form

This will allow you to select the Printer, then Print Preview the Chart before printing.
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View Options

View Options

The Chart in C-BrEase is intended to provide a quick visual display of the historic changes
in channel cross sections and the amount of cover or pile embedment remaining the the
bridge foundation.

To facilitate this activity, enhanced viewing of the details in the Charts by 

o Quick Panning and Zooming
o Comparing Cross-Section Values

https://www.helpndoc.com/feature-tour/iphone-website-generation
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Panning and Zooming

Panning

To Pan within a Chart, click the Left mouse button and drag the Chart.

Zooming

There are two ways to Zoom into a Chart

1. Move your mouse to the area of interest and rotate the mouse wheel
2. Select the Zoom => Box option from the Menu

and draw a box around the area you wish to Zoom into.

To Zoom back out, the easiest way to to select the Original View Option form the Zoom
Menu as below.
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Comparing Values

Comparing Values of Cross-Section Data

To compare Elevation values of the different cross-sections you can select the TRACE
option from the Menu bar or by right clicking on the Chart.  
Once enabled, you can move your mouse horizontally and see the station at the top of the
Chart and the corresponding values of each cross-section as shown below.

https://www.helpndoc.com
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Cycling through Cross-Sections

Cycling Through Cross-Sections

Cycling through the cross-sections allows the user to see the historic sequence for how the
channel has changed by having C-BrEase automatically Fade-In and Fade-Out cross-
sections chronologically.   To activate this command, choose the Cycle X-Section
command from the Cross Sections Menu as shown below.
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After activating the command, a Toolstripe will appear at the top of the Chart which will
allow you to control the cycle program.  

Options given are:
1. Push the Pause and Restart button to temporarily stop the program
2. Slide the scroll bar to change the speed of the Fade-In and Fade-Out
3. Select the checkbox to loop the cycle sequence
4. Select the Red Quit but to stop the cycle program
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Modifying the Chart

Modifying the Chart

To modify the Chart Items, use the Menu at the top of the Chart

From this Menu, you can modify or change the visibility of the bridge and cross-sections or
add specific notes or items to customize the presentation of the Chart.
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Modifying the Bridge

Modifying the Bridge

The Chart Menu provides the means to easily customize the bridge.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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You can Toggle the Visibility, Color or Material Type of any of the following items

o The Entire Bridge 
Use this option to make the Superstructure and all of the Substructure
Elements the same.

o The Superstructure
Use this option to change only the Superstructure.

o All Substructure Elements
Use this option to change all the Substructure Elements (Columns, Footings,
Tremie Seals and Piles).

o Individual Substructure Elements
Use this option to individually change various elements.

Changing the Transparency of the Bridge

To make the color of All of the bridge items transparent, select the value of Transparency
you desire under the Entire Bridge Menu as shown below.
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Notes:  Transparency only works when Colors are used for the bridge and will not
work for the Materials.

    The transparency settings will be applied to all bridge superstructure and
substructure elements equally.
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Toggling the Cross-Sections

Toggling On and Off the Cross-Sections

You can control which cross-sections are displayed on a Chart through the Cross Sections
Menu as shown below.

https://www.helpndoc.com/feature-tour/iphone-website-generation


C-BrEase

55 / 66

The cross-sections being currently displayed will have a "check" next to the date.

You can quickly turn all the cross-sections on or off by clicking the "Toggle All" menu Item.

To turn individual cross-sections on or off,  click on the specific cross-section of interest.
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Customizing the Lines

Customizing the Cross-Section Lines

You can control the Color, Line Thickness or Line Style from the Menu as shown below.

Color 

The current color is shown in the Menu.  If you click the word, "Color" then a color dialog
box will open by which you can choose whatever color you would like.

Line Thickness

The Line Thickness can be adjusted between a value of 1 (thin) to 10 (very thick).
The current line thickness is shown with a check mark.

Click on the thickness you would like for the line.

https://www.helpndoc.com/feature-tour
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Line Style

The Line Style can be changed using the Menu.

The choices are Solid, Dashed or Dashed-Dot.

Markers

The Markers can be customized by size and shape.

Marker Size

To change the size, select Markers => Size as below

The default setting is Dynamic which will adjust the marker size as you zoom in to maintain
a relative constant visual size.
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If you want to manually change the size, then you can choose from 1 to 4.

If you do not want to see the Markers, select 0 (OFF)

Marker Shape

Four marker shapes are availble through the menu system as shown below.

Note: The Rectangle shape is the dedault shape and used for charts without a prior
selection by the user.
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Annotating the Chart

Annotating the Chart

The add specific, descriptive information on the Chart, use the Annotate Menu Item.

With this Menu Option you have 3 types of information to add to the Chart: 

1. Text 
2. Lines
3. Rocks
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Text
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Adding Text (Comments)

To Add Text, 
1. Select Text from the Menu.

2. Left click on the location in the Chart to Add the Text
3. Type in the Text 
4. To Resize the Font, roll the mouse wheel
5. To complete the Text, left click the chart again.

Notes: 
1.  To Cancel the Text Entry, press the Esc Key prior to the second left click.
2.  All alpha numeric character and many symbols are allowed for text. 

However, commas are not allowed due to problems created with the file structure.

Modifying Text

To Move Text (including bridge item labels)
1. Right click on the chart and choose "Select Annotations Mode" or choose" Select
Annotation Mode" 
    from the Menu.

2. Right click again and choose "Move Annotations Mode"

3. Move the mouse over the item you want move and it should become italicized.  
    Left click on it and drag it to the new location.

To Rotate Existing Text
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1. Right click on the chart and choose "Select Annotations Mode"  or choose" Select
Annotation Mode" 
    from the Menu.

2. Right click again and choose "Rotate Annotations Mode"

3. Move the mouse over the item you want move and it should become italicized.  
    Left click on it and drag  to rotate it to a new angle

To Change Existing Text
1. From the Annotations Menu, choose "Edit Annotations"

2,  Inside the Annotations Table, you may change the value of the "Attibute" column to
the desired text.
3.  Click the Save Changes buttom at the bottom of the Table

Created with the Standard Edition of HelpNDoc: Write eBooks for the Kindle

Lines

Adding Lines

To add lines to the chart, you may select from 3 basic line style types as shown in the Menu:

1.  Select the Lines Menu Item and the Line Style

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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2.  Move your mouse to the beginning of where you would like to start the line and
Left      Click to set the anchor point.

3.  Move the mouse to where the line should end.
4.  Turn the Mouse Wheel to resize the line thickness.
     Note: To Cancel the Line, press the Esc Key 
5.  To end the line, left click at the end of the line.
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Rocks

Adding a Layer of Rocks

To add rocks to the chart, 

1.  Select the Rock Option from the Menu.

     2.  Left click at the beginning of the line of rocks.
3.  Move the mouse to where the line should end
4.  Rotate the Mouse Wheel to resize the size of the rocks.
     Note: To Cancel the Rocks, press the Esc Key 
5.  To end the rocks, left click at the end point.

Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease

Modifying An Annotation

Modifying An  Annotation
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Graphically
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Modifying an Annotation Graphically

To modify an existing annotation using the table, enable this feature from either the Menu or
by Right Clicking on the Chart and selecting "Select Annotation Mode" item.  After doing
so, you will see that it has a check next to the Menu Item as shown below.

Once the Selection Mode is turned on, moving the mouse over a text annotation or bridge
label will cause it to change to italic font.  
Clicking on the word once it is italicized will allow you to move the word or resize it using
the mouse wheel.

 In Selection Mode, Line and Rock Annotations will display Blue nodes at the start, end and
midpoints.

If you move the mouse over one of the blue nodes, it will change to red and 
o if the annotation is a Line, it will become dashed
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o if the annotation are Rocks, they will change colors

Object Modifications Options

1. If you rotate the mouse wheel, the annotation you are on will change size.

2. If you click the beginning or end nodes, you can move the end of the lines.

3. If you click the middle node, you can shift the location of the entire line.
4.

Text Modification Options

If in "Select Annotation Mode",  you can modify text by 

o Change the size by hovering over the text and rolling the mouse wheel
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In additon, by hovering over the text and right clicking you will see the following
menu:

o If the Move Annimations Mode is selcted as shown above, you can move the text
by selecting it with the Left mouse button and dragging

o If you want to Rotate the Text, right click on the text and choose the Rotate
Annotations Mode as below.

Once in the Rotation Mode, if you click on the text and drag it, it will pivot as you
drag the mouse.
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Tabularly

Modifying an Annotation Using the Annotation Table

To modify an existing annotation using the table, select the Edit Annotation Item from the
Menu

This will display a table of all the annotations on a Chart including the Type, Starting and
Ending Coordinates, Size and Attributes as shown below.

https://www.helpndoc.com/feature-tour
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To make a change, you can simple type into the cell, the new value (e.g., station, elevation,
size, etc.) and click "Save Changes".

To delete an annotation, select the row by clicking in the left most cell, then click "Delete
Selected Item".
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Removing Annotations

Removing   Annotations

To commands are available to remove annotations.

Undoing the Last Annotation
To remove the Last Annotation, select the "Undo Last Annotation" command from the menu
as shown below. 

Note: this command can be used successively to remove subsequent annotations;
however, once, an annotation is removed, it must be recreated to add it back to the chart.

Deleting a Specific Line or Rock Annotations
To remove a specific annotation, 

1. Turn on the Select Annotation Mode
2. Hover the mouse over one of the blue nodes
3. Right click and you will see a Delete Annotation Option to remove this annotation

https://www.helpndoc.com
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or you may click the "Delete" Key on the keyboard.

Clearing All Annotations
To remove all annotations from a Chart, simply select the "Clear All Annotations" command
as highlighted below.
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Writing Reports

Writing Reports

Documenting your project is easy with C-BrEase.  

In the General Form, select the Menu Option under File for Writing a Report

You are then given a choice as to what data you would like to include in the Report.

Check the items as shown below.
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Note:  You are able to select any Saved Chart Images to be included in the Report.
If no Charts have been "Saved", then you will be given the option to include the Chart
showing the full bridge and all cross-sections.

The Hydraulics and Scour check boxes will only be visible if you have the license for these
modules.

Finally, you will be prompted to choose a name and location for the file, then a PDF file will
be written and displayed on the screen.

Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease
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